
 PKZIP for Windows Help

Welcome to PKZIP for Windows!    You have selected the premier data compression program 
available to compress and extract files.    The world's most popular data compression 
program combines with the most widely-used interface to give you superior data 
compression that's easy to use.

PKZIP for Windows supports the Windows drag-and-drop feature.    Using the File Manager, 
you can drag a    .ZIP file onto the PKZIP for Windows icon and that .ZIP file will automatically 
open.    You can even drag a file onto the PKZIP for Windows icon to create a new .ZIP file.

Click on the PKZIP for Windows Help topic of your choice. The topics include:

Compressing    Files                                  Create new .ZIP files, add files to existing .ZIP 
files, and delete files from a .ZIP file.

Uncompressing Files                    Extract files from a .ZIP file, and test the 
integrity of    those files.

Viewing Files Within A .Zip File Viewing files contained in a .ZIP file without 
actually extracting the files.

Setting Options and    Preferences        Set options to view and sort files, cascade and
tile files, and set preferences for compressing,
extracting, and viewing.

License Information        License information.

For Help on Help, Press F1



Compressing Files

Creating A New .ZIP File                Learn how to create a new .ZIP    file.

Adding Files To An Existing .ZIP File          Learn how to add files to an existing .ZIP 
file.

Deleting Files From An Existing .ZIP File     Learn how to delete files from an 
existing .ZIP file.



Uncompressing Files

Extracting Files From    A .ZIP File      Learn how to extract files from a .ZIP file.

Testing .ZIP File Integrity              Learn how to test the integrity of the files
contained in a .ZIP file. Let PKZIP check 
that the file(s) aren't corrupt and that 
they contain valid CRC values.



Setting Options and Preferences

Setting View Options:

PKZIP Viewing Options Erase gridlines, turn on and off the toolbar, 
and zoom in out.
 

Sorting Files Within A .ZIP File Sort the files within a .ZIP file by filename, 
extension, size or date.

Cascade And Tile .ZIP Files Cascade (overlap) and Tile (fit next to each 
other) .ZIP files you have opened.

Setting PKZIP for Windows Preferences:

Zipping                            Set the preferences for compressing files.

Unzipping            Set the preferences for extracting of files.

Viewing Files Set the preferences for viewing files.



License Information
PKZIP® for Windows            Version 2.01        2-15-96
Copyright©    1989-1996    PKWARE Inc.      All Rights Reserved.      
PKZIP Reg. U.S. Pat. and Tm. Off.        Patent No. 5,051,745

PKWARE DISCLAIMS ALL WARRANTIES AS TO THIS SOFTWARE, WHETHER EXPRESS OR 
IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, FUNCTIONALITY OR DATA INTEGRITY OR PROTECTION.

See documentation for further disclaimers and information.

For use on multiple machines or to use to distribute your information or software, a separate
license is required.    See the file LICENSE.TXT for further information. 

 



Creating a New .ZIP File

You can create new .ZIP files in the following ways:

*    Using the Windows drag and drop feature.

*    Selecting File from the PKZIP for Windows Menu bar and New from the File 
menu.

*    Using the Tool bar button.

Drag and Drop
PKZIP allows you to create .ZIP files by dragging and dropping files using the Windows File 
Manager.    This method gives you a quick and easy way to compress files.    When you use 
this method, you can't set .ZIP preferences because PKZIP compresses the file immediately. 
PKZIP uses the current settings for these preferences.

To create a new .ZIP file using drag and drop:

1.    Start PKZIP for Windows by double-clicking on the icon. The PKZIP for Windows 
main    application screen appears.

2.    Using the File Manager, locate a file you want to compress in the new .ZIP file and
drag it on top of the PKZIP for Windows screen where no .ZIP file appears. (If you 
drop it on top of a .ZIP file, the file will be compressed into that .ZIP file.) The Save
as dialog box appears. 

3.    Type a name for your new .ZIP file and click on OK. PKZIP begins to compress the 
file and a box appears that displays the contents of the .ZIP file.

The PKZIP Menu Bar
Creating a .ZIP file using the PKZIP Menu bar gives you more control in compressing and 
extracting files. Use this method if you want to take full advantage of PKZIPs features.

To create a new .ZIP file from the menu:

1.    Start PKZIP for Windows by double-clicking on the icon. The PKZIP for Windows 
main    application screen appears.

2.    From the Menu bar, select File. The File menu appears. Select New. The Save As 
dialog box appears.

3.    Type a    name for your new .ZIP file and click OK. The following Add Files dialog 
box appears:



4.    Select the files you want to compress.
 

To add individual files, select the file(s) from the Windows file list and click on 
Add Files.

To add all files in a directory, select the directory and click on Add Directory.

To add files that match a file pattern, type a pattern (for example, *.TXT) in the
Filter box, then click on Add Filter. PKZIP displays the selected files in the 
Files & Directories to .ZIP box.

To manually add files or file patterns, click on Manual add. The Manual Add 
dialog appears.    Type a filename or file pattern (using DOS rules) and click on 
OK. 

To exclude files that match a specified file pattern, type a pattern (for example,
*.TXT) in the Filter box, then click on Exclude filter. PKZIP displays the 
excluded file pattern preceded by the Exclude = in the Files & Directories 
to .ZIP box.

Before you start the compression, you can edit the files or file patterns you 
have selected. To remove individual files from the list, select the file(s) then 
click Remove. To remove every file in the list, click on Remove all. To 
exclude/include files in the list, select the file(s), then click on Toggle 
Include/Exclude. To toggle back, click on Toggle Include/Exclude again.



5.      Set    .ZIP preferences , if needed, by clicking on the Preferences button.

6.      To assign a password to the .ZIP file, click on Password. PKZIP will prompt you 
for a        password when you click on OK to start compressing.

To delete the original files from your hard disk after they have compressed and put
into the .ZIP file, click on Move files.

7.      When you have finished selecting the files to compress, click on OK. PKZIP 
begins to compress your files and the Add Status dialog box appears. 

The first line displays the percentage completed for the entire .ZIP file.    The second line 
displays the percent completed for the current file that is being compressed.    The lower 
area shows how each file was compressed and the overall percentage that it was 
compressed.

After all the files are compressed, select the OK button to remove the Add Status dialog box. 
PKZIP opens the .ZIP file and displays the contents of the file.

Using the Tool Bar Button
To create a new .ZIP file using the Tool bar button:

1.      Click on the  button. The Save as dialog appears.

2.      Follow steps 3 through 6 in The PKZIP Menu Bar. 



Adding Files to an Existing .ZIP File

With PKZIP, you can add files to an existing .ZIP file. You can:

*    Add new files (add only files that are not currently in the .ZIP file).

*    Update existing files (update files within a .ZIP file with newer versions of 
those files).

*    Add and update files (add and update files).

To add files:

1.    Open the .ZIP file you want to add files to. PKZIP displays the contents of the .ZIP 
file.

2.    From the Menu bar, select Zip. The Zip menu appears.

3.    Select Add files. The Add Files dialog box appears:

 

4.    Select the method of adding files. These methods appear in the Add Options 
area of the dialog box. 

To only add new files to your .ZIP file, click on Add files.



To only update existing files within the .ZIP file, click on Update files.

To add new and update existing files, click on Add & Update Files.

To assign a password, click on Password. PKZIP for Windows will prompt you 
for a password when you click OK to start compressing.

To delete original files (from the disk drive) after they are compressed, click on 
Move files. 

5.    Select files to .ZIP.    You can select files in the following ways:

To add individual files, select the file(s) from the Windows file list and click on 
Add Files.

To add all files in a directory, select the directory and click on Add Directory.

To add files that match a file pattern, type a pattern (for example, *.TXT) in the
Filter box, then click on Add Filter. PKZIP displays the selected files in the 
Files & Directories to .ZIP box.

To manually add files or file patterns, click on Manual Add. The Manual Add 
dialog box appears.    Type a filename or file pattern (using DOS rules) and click
on OK. 

To exclude files that match a specified file pattern, type a pattern (for example,
*.TXT) in the Filter box, then click on Exclude Filter. PKZIP displays the 
excluded file pattern preceded by the Exclude = in the Files &    Directories 
to .ZIP box.

To remove files from the list, select the file(s) then click Remove. To remove 
every file in the list, click on Remove all. To exclude or include files in the list, 
select the file(s), then click on Toggle Include/Exclude. To toggle back, click 
on Toggle Include/Exclude again.

6.        Set .ZIP preferences , if needed, by clicking on the Preferences button.

7.      When you have finished selecting files to compress, click on OK. PKZIP begins to 
compress your files and the Add Status dialog box appears. 

The first line displays the percentage completed on the entire .ZIP file.    The second line 
displays the percent completed for the current file that is being compressed.    The lower 
area shows how each file was compressed and the overall percentage that it was 
compressed.

After all the files are compressed, click on the Done button to remove the Add Status box.    
PKZIP opens the .ZIP file and displays the contents of the file.



Deleting Files From an Existing .ZIP File

PKZIP allows you delete files from a .ZIP file. 

To delete files:

1.    Open the .ZIP file you want to delete from. PKZIP displays the contents of the .ZIP
file.

2.    Select the files you want to delete.    

3.    From the Menu bar, select Zip. The Zip menu appears. 

4.    Select Delete files from the Zip menu. The Delete Files dialog box appears.

5.    To delete the files, click on Yes. PKZIP deletes the files and the Delete dialog 
closes.

To cancel without deleting the files, click on No. No files are deleted.

 



Extracting Files From a .ZIP File

Extracting files from a .ZIP file is as easy as compressing. You can extract a single file or 
multiple files. 

To extract files:

1.    Open the .ZIP file from which you want to extract. PKZIP displays the .ZIP file.

2.    Select the files you want to extract. To select a file, hold down your CTRL key and 
click on that file. To select a group of files, hold down the left mouse button and 
drag over the files. You can also use the Select option on the Menu bar.

3.    From the Menu bar, select Unzip. The Unzip menu appears.
                    
4.    Select Extract files. The following Extract files dialog box appears:

The Extract area in this dialog box indicates that you are extracting all of the 
files from the .ZIP file or just selected files.

The Statistics area contains the number of files being extracted and the total 
number of bytes for those files. This area is informational only.

The Extract to area allows you to select a destination for the files being 
extracted.

The Password area allows you to enter a password for the .ZIP file, if 
necessary.

5.    If the .ZIP file you are extracting from contains a password, you must enter that 
password before you can extract files. Type the password in the Password box.

If the .ZIP file doesn't contain a password, leave the Password box blank.

6.    Select a destination for the files being extracted. You can either extract to your 



hard disk or to a printer. If you extract to your hard disk, you can either type a 
location - such as a drive or directory path - or you can use the Browse button to 
access your hard drive for a location.

7.    Set    Preferences , if needed, by clicking on the Preferences button and clicking 
on the appropriate radio buttons and checkboxes. 

8.    When you have finished selecting a destination, click on Extract to start 
extracting.    PKZIP displays the Extract box.

As PKZIP extracts the files, it displays the status entire extraction in the 
Progress area of the dialog box. The name of the current file being extracted 
appears next to the word Filename.    The percent completion changes as it 
extracts. As each file is extracted, an OK appears next to that file.      At the 
bottom of the dialog box, PKZIP displays the number    of warnings.

9.    When the last file is extracted, PKZIP displays a Done message. When you see 
this message, click on the Done button to exit.



Testing the Integrity of a .ZIP File

It is always a good idea to test the integrity of a .ZIP file before you extract. If a file within 
a .ZIP file is bad or corrupt, you might not be able to extract that file. 

To test files:    

1.    Open the .ZIP file you want to test. PKZIP displays the .ZIP file.

2.    Select the files you want to test. To select a file, click on that file. You can also use
the Select option on the Menu bar.

3.    From the Menu bar, select Unzip. The Unzip menu appears.
                  
4.    Select Test files. The Test Files dialog box appears.

The File Selection area indicates that you are testing all files in the .ZIP file 
or selected files. If you selected all files you cannot change this area. If you 
selected only some of the files, you can change your mind here and click on 
All files.

The Statistics area contains the number of files being tested and the total 
number of bytes for those files. This area is informational only.

The Password area allows you to enter the password for this .ZIP file, if 
necessary. 

5.    If the .ZIP file you are testing contains a password, you must enter that password 
before you can test files. Type the password in the Password box. 

If the .ZIP file doesn't contain a password, leave the Password box blank.

6.    To start testing, click on Test Integrity. PKZIP begins to test the file(s) and 
displays the Extract/Test Zip box.

As PKZIP tests the files, it displays the status of each file individually and of the
entire test, in the Progress area of the dialog box. The name of the current file 
being tested appears next to the word Filename.    The percent completion 
changes as it tests. As each file passes the test, an OK appears next to that 
file. At the bottom of the dialog box, PKZIP displays the number of warnings 
and errors.

7.    When the last file is tested, PKZIP displays a Done message. When you see this 
message, click on the Done button to exit.

 



Viewing Files Within a .ZIP File
When you open a .ZIP file, you might want to view the contents of one of the compressed 
files. PKZIP allows you to open individual application files right from the .ZIP File Display 
Window. You dont even have to extract the file from the .ZIP file. 

To view the contents of an application file:

1. Open the desired .ZIP file. 

2.    Specify a temporary directory for PKZIP to extract the file. To do this, select Unzip
from the Menu Bar, Preferences from the Unzip menu, and enter the directory in 
the Temporary Extract Directory box.

3.    Select the file you want to view by double-clicking on the file. PKZIP for Windows 
extracts the file into the temporary directory and the file opens. 

The file you open needs to have a Windows file association for that type of file.    For 
example, to view the WIN.HLP file, which has a windows file association of Winhelp for .HLP 
files, double clicking will cause winhelp to run the WIN.HLP file.

If there is no file association for that file type, an error message appears. Please refer to your
Windows manuals for further details about file associations.

 



PKZIP Viewing Options

PKZIP for Windows contains several different options to view a .ZIP file. These options appear
on the View menu. 

The GridLines option allows you to turn on and off the gridlines that border the list of files.

The Zoom In option allows you to zoom in to the .ZIP file contents. 

The Zoom Out option allows you to zoom out of the .ZIP file contents. 



Sorting Files Within a .ZIP File

PKZIP allows you to sort the files within a .ZIP file on your screen several different ways, 
making it easier to find the files that you want. 

To sort files, use the Sort option on the Menu bar.

Sort by Filename in ascending or descending order. Ascending is normal alphabetical 
order. Descending is reverse alphabetical order.

Sort by File Size in ascending or descending order. Ascending is from smallest to largest. 
Descending is from largest to smallest.

Sort by Date in ascending or descending order. Ascending is from oldest to newest. 
Descending is from newest to oldest.

Sort by Compression Ratio in ascending or descending order. Ascending is from smallest 
to largest. Descending is from largest to smallest.

Sort by CRC 32 value in ascending or descending order. Ascending is from smallest to 
largest. Descending is from largest to smallest.

Unsorted does not sort the files. They appear in the order that they were compressed.



Cascade and Tile .ZIP Files

You might find it necessary to open multiple .ZIP files at the same time. PKZIP makes it 
easier to view these files by providing two ways to arrange the .ZIP File Display Windows 
that contain them.

To arrange windows, use the Windows option on the Menu bar.

Cascade - This option allows you to place the .ZIP File Display Windows on top of each 
other, with only the top part of each window showing. Each window is slightly lower and to 
the right of the one below it. You can still access all files, you just can't see the entire 
contents of the each .ZIP file.

Tile -    This options allows you to give equal space to every window you have opened. You 
can see the partial contents of each window,    but each one is relatively small.



.ZIP Preferences
When you create a new .ZIP file or add files to a .ZIP file, you can change various .ZIP 
parameters. This provides greater flexibility for compressing files.

When you select Preferences from the .ZIP menu, or click on the Preferences button in 
the Add Files dialog box, PKZIP displays the .ZIP Preferences dialog box.

Note: To set the changes as the new defaults, click on Save as default instead of 
OK. This sets defaults for all changes made in this box.

Compression Area

This area allows you to change the compression method. Click on the radio button that 
appears next to the method you want to use.

Super fast - Use this method if want the fastest, but the least compression. If speed is a 
priority, this method is for you.

Fast - Use this method if you want the second fastest compression and the second least 
compression. This method is slower than Super fast but provides more compression.

Normal - Use this method if you want the best balance of speed and compression. This is 
the default method. 

Extra - Use this method for the most - but slowest - compression. If compression if a 
priority, this method is for you. 

Store - Use this method if you want no compression, and you only want to back up the .ZIP 
file, or if you know that a file will not compress well, for example, a .GIF file. 

Attributes Area



This area allows you to include files in your .ZIP file that contain specific attributes. You can 
select as many file attribute types as you want. 

Read-only -    Compress read-only files.

Hidden - Compress hidden files. (Hidden files cannot be displayed in Add Files or using the 
DOS dir command. They are displayed when they are in a .ZIP file.)

System - Compress system files. These files are used by the operating system.

Retain attributes - Retain the attributes in the .ZIP file so you can extract the files with the
attributes.

.ZIP File Date Area

This area allows you to set the date of a .ZIP file. Click on the radio button that appears next 
to the date you want to use.

Today's date - Apply today's date to the .ZIP file.

Newest date - Apply the date of the newest file within the .ZIP file to the .ZIP file.

Oldest date - Apply the date of the oldest file within the .ZIP file to the .ZIP file.

Retain .ZIP Date - Keep the current date of the .ZIP file.

Path Information Area

This area allows you to store directory path information in your .ZIP file. For example, if you 
compressed a file from the \doc\resume directory, you can include the \doc\resume in 
your .ZIP file.

No path information - Do not include path information with each file in the .ZIP file; only 
include the filename.

Relative path - Include relative path information with each file in the .ZIP file.

Full path - Include the entire path with each file in the .ZIP file. 

Archive Bit Area

ZIP if archive bit is set - Compress files that have had their archive bit set, which means 
the file has changed since the last backup.

Clear archive bit - Clear the archive bit after the file is compressed.

Miscellaneous Area



This area contains more options that add flexibility to your data compression.

Include subdirectories (Recurse) - Compress files that appear in subdirectories of the 
current directory. If you use this option, you don't have to select the files within each 
subdirectory.

Store volume label -    Store the volume label from the desired drive within the .ZIP file.



Unzip Preferences
When you extract a file from a .ZIP file, PKZIP allows to change various .ZIP parameters. This
provides greater flexibility for extracting files.

When you select Preferences from the Unzip menu, or click on the Preferences button in 
the Extract Files dialog box, PKZIP displays the following ZIP Preferences dialog box.

Note: To set the changes you make in this dialog as the new defaults, click on Save 
As Default before you click on OK. This sets defaults for all changes made in 
this box.

Extract Options Area

This area allows you to control how PKZIP handles files being extracted that have the same 
name as files in the target directory (the directory you are extracting to). 

Overwrite - Overwrite files in the target directory without prompting you.

Update - Extract files that contain a file with the same name and date in the target 
directory and that are newer than the files in the target directory.

Update & New - Extract files that contain a file with the same name in the target directory,
is newer than the file in the target directory, and any files that are not in the target directory.

Prompt user - Prompt you to overwrite or not overwrite a file in the target directory.

Restore Attributes Area

This area allows you to restore the file attributes for the files being extracted. You can select 
as many of these file attribute types as you want.

Read-only - Restore the read-only attribute for affected files.



Hidden - Restore the hidden attribute for hidden files that are extracted.

System - Restore the system attribute for system files that are extracted.

Options Area

This area contains more options that add flexibility to your data extraction.

Create directory - Restore the directory structure for the files that are extracted.

Restore volume label - Restore the volume label if a .ZIP file contains one.

Temporary Extract Directory Area

This area allows you to specify a temporary extract directory for when PKZIP temporarily 
extracts files. For example, when you open an application file, PKZIP has to temporarily 
extract that file.
 



Viewing Files Preferences

When you view files within a .ZIP file, PKZIP allows to change various viewing parameters. 
This provides greater flexibility for viewing files. The changes you make in this box affect 
all .ZIP files you have open.

When you select Preferences from the View menu,    PKZIP displays the View Preferences 
dialog box.

Note: To set the changes you make in this dialog as the new defaults, click on Save 
as default instead of clicking on OK. This sets defaults for all changes made 
in this box.

Display Area

This area allows you to control    the categories of information PKZIP displays for each file 
within a .ZIP file. When you first display the View Preferences dialog box, all categories are
displayed. Turn off and on the categories that you want. 

File Size - Display the size of the file before it was compressed.

File Date/Time - Display the time and date of the file.

Attributes - Display the attributes of each file.

Compressed Size - Display the size of the compressed file.

CRC 32 - Display the Cyclic Redundancy Check (CRC) value for each file.

Comment - Display the comment, if one exists.

Method - Display the compression method PKZIP used when compressing.

View Area

This area allows you to include or exclude grid lines and row numbers in the .ZIP File Display 
Window. When you first display the View Preferences dialog box, all view options are turned 
on.    Turn off and on the options that you want. 

Grid Lines - Display grid lines that border the .ZIP File Display Window.

Row Numbers - Display the row numbers that appear to the left of each file.

Sort By Area

This area allows seven different ways to sort the files within a .ZIP file.

Filename - Sort files by filename.

Extension (type) - Sort files by file extension (for example, .TXT). 



File Size - Sort files by file size.

File Date/Time - Sort files by date and time.

Compress ratio - Sort by compression ratio, which is the ratio of uncompressed size to 
compressed size. 

CRC 32 - Sort by CRC (Cyclic Redundancy Check) value. 

Unsorted - Do not change sort order displayed when you first opened a .ZIP file. 

Sort Order Area

This area coincides with your selection in the Sort By area and allows you to sort in 
ascending or descending order. 

Ascending/Descending:    

by filename - Ascending is normal alphabetical order. Descending is reverse alphabetical 
order.

by extension -  Ascending is normal alphabetical order. Descending is reverse alphabetical 
order.

by file size    - Ascending is from smallest to largest. Descending is from largest to smallest.

by date/time - Ascending is from newest to oldest. Descending is from oldest to newest.

by compress ratio - Ascending is from smallest to largest. Descending is from largest to 
smallest.

by CRC 32  - Ascending is from smallest to largest. Descending is from largest to smallest.

unsorted - Ascending and Descending does not apply to this sort method.

.

 



Opening an Existing .ZIP File

You can open a .ZIP file in PKZIP several different ways. You can:

*    Start PKZIP, then using the File Manager, drag the file onto the PKZIP main 
application window.

*    Start PKZIP, then select the file from the list of most recently-opened files 
on the File menu. This list appears at the bottom of the File menu.    

*    Start PKZIP, select File from the Menu bar and Open from the File menu.     
from the        Menu bar. PKZIP displays the Open File dialog.

*    Open a DOS window and type PKZIPW and the name of the .ZIP file.

*    Using the File Manager, drag the file onto the PKZIP icon.



Selecting Files

You can select files in several different ways. You can use the PKZIP Tool bar or the Select 
option on the Menu bar.

Selecting All Files
 

To select all files in the .ZIP file that are opened, click the  button on the PKZIP Tool bar. 
To unselect all files, click on the 

 button on the PKZIP Tool bar.      

Selecting Files Based On Filename
To select files by filename:

1.    Using the PKZIP Tool bar, click on the  toolbar button. 

Using the PKZIP Menu bar, select Select from the Menu bar. 

2.    Select by Filename. The Select by filename dialog box appears.

3.    Type a filename or file pattern in the Enter the file pattern: box. You can use DOS 
wildcards, even multiple ones at the same time (for example, *drive*    B*). To 
consider case, click in the Case sensitive checkbox. To ignore pathnames in your
selection, click in the Ignore Path Names checkbox.

4.    When you have finished typing a filename or file pattern, click on OK. Your files 
are selected and PKZIP highlights those files in the .ZIP File Display Window.

Selecting Files Based On File Size

To select files by file size:

1.    Using the PKZIP Tool bar, click on the  toolbar button. 

Using the PKZIP Menu bar,    select Select from the Menu bar. 

2.    Select by File Size. The Select by file size dialog box appears.

3.    Select the criteria for specifying file size. The If the file size is contains a pop-up 
menu, with the following choices:

Less than
Greater than
Equal
Between



Select one of these by clicking on the item you want, then type the size on 
which you are going to base the selection. For example, if you want to select 
all files that are less than 1000 bytes, you would click on less than, then type 
1000 in the box that appears next to the word bytes.

4.    When you have finished specifying the size, click on OK. The files are selected 
and PKZIP highlights those files in the .ZIP File Display Window.

Selecting Files Based On File Date

To select files by file date:

1.    Using the PKZIP Tool bar, click on the  toolbar button. 

Using the PKZIP Menu bar,    select Select from the Menu bar. 

2.    Select by File Date. The Select by file date dialog box appears.

3.    Select the criteria for specifying file size. The File size contains a pop-up menu, 
with the following choices:

Before
On
After
Between

Select one of these by clicking on the item you want, then type the size on 
which you are going to base the selection. For example, if you want to select 
all files that were created after 12/10/1994, you would click on before, then 
type 121094 in the box that appears next to the (Format MM/DD/YY).

4.    When you have finished specifying date, click on OK. The files are selected and 
PKZIP highlights those files in the file display box.

Cascade .ZIP File Windows

Use this command to overlap each .ZIP File Display Window. Each window is slightly lower 
and to the right of the one above it.    



Tiling .ZIP File Windows

Use this option to arrange multiple-opened .ZIP files so that each .ZIP File Display Window is 
given equal size. 



Current .ZIP Files Open

PKZIP displays a list of currently open .ZIP files at the bottom of the Window menu.    A 
checkmark appears in front of the document name of the active window.    Active means the 
file is currently highlighted. Click on a different window to make it active.



Help Index Option
 
Use this option to display the main Help screen.    From this screen, you can jump to 
additional Help screens that contains step-by-step instructions on using PKZIP.    

To return to the main Help screen from anywhere, click the on Contents button.



Using Help Option

Use this option for instructions on using Help.



About Option

Use this option to display the copyright notice and version number of your copy of PKZIP.



New .ZIP File Command

Use this command to create a new .ZIP file.    

To open an existing .ZIP file, use the Open command

Shortcuts
Keys: CTRL+N



Open Existing .ZIP File

Use this option to open an existing .ZIP.      PKZIP allows you to browse your hard drive to 
locate the .ZIP file.

To create a new .ZIP file, use the New command.

Shortcuts
Keys: CTRL+O



File Open Dialog Box

The following areas allow you to specify a file to open:

File Name
Type or select the file you want to open.    This box contains files that have the extension 
you select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open, if it isnt a .ZIP file.

Drives
Select the drive that stores the file you want to open. 

Directories
Select the directory that stores the file you want to open.

Network...
Select this button to connect to a network location and assign it a new drive letter. 



Close .ZIP File Option
 
Use this option to close the active .ZIP file.    



Most Recently-Used .ZIP Files

Use the numbers and filenames listed at the bottom of the File menu to open the last 
four .ZIP files you closed.    Select the number or click on the name that corresponds with the
.ZIP file you want to open.



Exit PKZIP 
 
Use this option to end this PKZIP session.

Shortcuts
Mouse: Double-click the application's Control menu button.

              Keys: ALT+F4



Extract Dialog Box

This box shows information on extracting files.

See Also:

Extracting Files From a .ZIP File



Test Dialog Box

This box shows information on testing.

See Also:

Testing .ZIP File Integrity



Add Status Box

The Add Status box appears when you add files to a new or existing .ZIP file.

See Also:

Adding Files to an Existing .ZIP File
Creating a New .ZIP File



Overwrite Existing File

This message box appears when you extract a file from a .ZIP file and there is a name 
conflict. A name conflict occurs when a file being uncompressed has the same name as a file
already on the destination disk drive.    



Browse For Directory

This button allows you to search for the desired drive and directory.



Manual Add Dialog Box
This box allows you to manually type the filename or file pattern you want to compress 
(instead of selecting it from a list). You can use DOS wildcards. For example, to compress all 
files that end in .TXT, you could type *.TXT.



File Save As Dialog Box

The following options allow you to specify the name and location of the file you're about to 
create:
File Name

Type a new filename to save a file with a different name. 
Drives

Select the drive in which you want to store the file.
Directories

Select the directory in which you want to store the file.
Network...

Select this button to connect to a network location, assigning it a new drive letter. 

Save files as type
Select the type of file you want to create.    The file can be a standard .ZIP file, a self-    
extracting file (.EXE)    or a junior self-extracting file (.EXE).



Default Directories Dialog Box
This box allows you to set the default directory for when you add files or open files.



.ZIP File Statistics Dialog Box
The .ZIP file statistics dialog box displays the number of compressed files, the total 
uncompressed size of the files, the total compressed size of all the files and the overall 
compression ratio.



License Option
Displays the PKZIP for Windows license information

 



Selecting a Directory
This area displays the current directory.    To change directories, double click on the folders.



Selecting a Drive 
This area displays the current drive. To select a new drive, click on the down arrow, then 
click on the new drive.



OK Button
This button saves the dialog and continues with the current process.



Cancel Button
This button stops the current process.



Help Button
This button displays help on the current dialog box.



Network Button
This button allows you to connect to a network location, assigning it a new drive letter. 



List of Files in the Current Directory
This area displays the files in the current directory.    You can select these files to be 
compressed.



Filter 
This area allows you to type filters (file patterns), for example, *.TXT or *.DOC. To type 
multiple filters, separate each filter with a semicolon (;).Filter will only take files of that 
particular type.    The filter can be selected from the list of the most recently used filters.    
The filter information will remain the same when moving from directory to directory.    When 
the filter is selected, only the files that fit the filter will be compressed.



Files & Directories to ZIP
This area contains the files and directories you have selected to compress. You can edit this 
list by using the buttons that appear on the lower right part of the Add Files dialog.



Add Files Button
This button adds the files that are currently selected to the Files & Directories to ZIP box.



Add Directory Button
This button adds all of the files from the current directory to the Files & Directories to ZIP 
box.



Add Filter Button
This button adds all of the files that match the current filter (for example, *.TXT) to the Files 
& Directories to ZIP box.



Exclude Filter Button
This button excludes all of the files for compression that match the filter. For example, to 
exclude all files that end in .TXT, you would select the *.TXT filter, then click on the Exclude 
Filter button.



Manual Add Button
This button allows you to type files or file patterns to be compressed (instead of selecting 
them from a list).



Add Options Area
This area allows you to compress new files (Add files), update existing files in the .ZIP file 
(Update files) or add and update files (Add & Update files). You can also move files from your
hard drive to the .ZIP file, and assign a password to your ZIP file.



Toggle Include/Exclude Button
This button toggles between including and excluding files in the Files & Directories to ZIP 
box.



Remove Button
This button removes the files that are selected in the Files & Directories to ZIP box. You must
select at least one file from the Files & Directories box to use this button.



Remove All Button
This button removes all of the files from the Files & Directories to ZIP box.



Preferences Button
This button displays the ZIP Preferences dialog, which allows you to change preferences for 
compressing files. For example, you can select a compression method and store directory 
path information.



Compression Area
This area allows you to select a compression method. Super fast is the fastest method that 
has lower compression. The Fast method is a little faster with better compression. Normal 
offers the    best balance of compression and speed. Extra offers the most compression but 
at a slower speed. Storing performs no compression. It just stores the files in the .ZIP file in 
their normal size.



.ZIP File Date Area
This area allows you to set the date of the .ZIP file.    Select from Todays date, date of the 
Newest file, the date of the Oldest compressed file, or to Retain .ZIP date.



Path Information Area
This area allows you to store path information in the .ZIP file. No path information does not 
include any path information in the .ZIP file.    Relative path stores path information for 
recursed subdirectories only.    Full path stores the entire path information for all files 
compressed.



Attributes Area
This area allows you to compress files with the selected attributes.    When the Retain 
attributes box is checked, the files will retain their attributes after compression. (PKZIP 
normally skips files that contain these attributes.)



Miscellaneous Area
This area allows you to include subdirectories (recurse), and to store volume labels.



Preference OK Button
This button sets the preference(s) for the current session only. It does not save the 
preferences for the next time you run PKZIP.



Save as Default Button
This button saves the preferences for the current session and all subsequent sessions, until 
you make changes and click on this button again. The next time you run PKZIP, these 
preferences will take affect.



Extract Files Selection Area
This area indicates whether you are extracting all files or selected files.



Extract Statistics Area
This area displays the number of files and total bytes to be extracted, and is informational 
only.



Extract to Area
This area allows you to select whether you want to extract to disk or printer. If you extract 
the files to disk, you can select the directory into which you want to extract the files (using 
the Browse button).



Password Area
This area allows you to enter a password, if required. If a .ZIP file contains a password, you 
must enter that password before you can extract files.



Extracted/Tested File List
This area shows the files to extract or test, and if any warnings occurred.



Extract Options Area
This area allows you to set the extraction options when uncompressing files.    The Overwrite 
option will overwrite files without prompting. Select Update to only extracts newer files that 
already exist in the directory. Select Update and new to extract newer files and files that 
previously do not exist.    Select Prompt user    to have PKZIP prompt you when it encounters 
an overwrite situation.



Restore Attributes Area
This area allows you to restore the selected file attributes while extracting.



Extraction Options Area
This area allows you to create directories and store volume labels. The Creating directories 
option will recreate any directory information stored in the .ZIP file. The Restore volume 
label option restores the volume label, if stored.



Temporary Extract Directory Area
This area allows you to set the temporary directory that is used when a compressed file is 
viewed.



Extract Preference Button
This button displays the Unzip Preferences dialog, which allows you to set preferences for 
extracting files.



Extract Button
This button starts the extraction.



Archive Attribute Area
This area allows you to compress only files that have had their archive bit set. If you check 
the ZIP if archive bit set box, only the files with the archive attribute set will be compressed.  
If you check the Clear archive bit box, the archive attribute will be cleared after the file is 
compressed.



Directories Button
This button allows you to specify default directories for when you add files to be compressed
or for when you open .ZIP files. You can also select a temporary directory for compression.

 




